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By Guy Roels, (c)2006-2007 RGS-AvanceSoft, Free Edition
Special thanks to our AvancePaint beta-testers team

AvancePaint URL: http://users.belgacom.net/rgssoft/avancepaint.htm
where you can also find our PayPal account.
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                                    avancesoft@skynet.be

This version is not crippled in anyway and fully functional in all respects!
Nevertheless, you can upgrade to a Professional Edition which gives 
you extra functionality options and support. 
Please read further in the manual for more details on 
upgrading this Free Edition to the Pro Edition.
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About

AvancePaint is NOT public domain! The author keeps the copyright and all other rights. 
You can upgrade your Free Edition to the Pro Edition and receive a life time valid key!

To request the Pro Edition of AvancePaint please send 10 Euro (13 US$).
You can donate via PayPal, by post or our bank account.

A complete paint program designed with a intuitive user interface 
that makes AvancePaint easy to learn and use.

Although there are many other drawing programs out there, and surely much more powerful
programs (PhotoShop and such), not many could easily replace MS-Paint in its simplicity but

with more possibilities without an overkill on (rarely used) options. 
It was my intention to make a basic paint program that has the capabilities of MS-Paint, but with

a lot more tools and photographical effects but should still be easy to use! 
It’s powerful enough to suit the advanced user and yet simple enough to please the beginner.

Open unlimited number photo's or pictures and unleash your artistic talents 
as you will discover the advanced and powerful but easy to use graphical options!
A complete set of 25 photo-realistic filters and more then 40 textures are included.

Credits
IJL15.DLL (Intel) An interface to Intel's IJL (Intel JPG Library)
FX.DLL 1.03 SDK (C) Martins Skujenieks 2003 http://www.exe.times.lv
EZTW32.DLL www.twain.org/www/toolkit.html

AvancePaint compatible operating systems:
Windows 95/98/98se/Me/2k/3k/NT/XP/Vista

What is new and History

History
Version 1.0

- The mother of all (AND future) versions
- What’s new? Everything…;-)

Version 1.1
- Mainly bug fixes

Version 1.2
- Released as Free Edition with possibility to upgrade to the Pro Edition
- New GUI: icons, layout, style and workspace
- New: Effects browser > More powerful, faster and easier to use photographical 

effects
- New: Enhance
- New: Dissolve
- Extra borders and textures
- Several bug fixes

Version 1.2.5



- Priority update:
- Program quitted after save/export JPG: Runtime error 53 - File not found ijl11.dll or 

ijl15.dll -> Fixed
- default filenames truncated (untitled.jpg -> unti.jpg) when saving - fixed
- filename not parsed in export JPG 

Version 1.2.7
- Priority update:
- Effects Browser quitted: Runtime Error 53 – File not found fx.dll -> fixed
- Error 481 in Texture Fill when user selected a graphic file that has an incorrect file 

extension:
User tried to assign a graphics format other than a bitmap, icon, jpg or gif to a texture
(even if the extension is a .bmp, .gif, .jpg because the file format does not 
correspond to the file extension)

- New: icon (.ICO) format support in texture fill    

Version 1.2.8
- Installation program updated (more compatible with Vista)
- Effects Browser now compatible with Windows Vista

Version 1.2.9
- Extra Pro-edition photo effects were not always available on some systems
- Remember program window size did not work correctly in Pro-edition
- Effects browser: spot light default setting now medium

§     : light -> spot light
§     : show effect name currently using

- - New Pro-edition option: enable/disable automatic save/restoring screen positioning 
and size

- - About-box -> shows correct registering info

Version 2.0
- Several cosmetic changes
- New: Draw advanced Polygons - move points, color, thickness etc...
- New: Draw Advanced Bezier curves - move points, color, thickness etc...
- New: Twain compatible! (Eztw32.dll)
- import images/pictures from your scanner, cam etc. any twain compatible device!
- New: Pencil now also acts as an Eraser when right mouse-button is pressed 
- New: 5 new pencil color mixes (user selected color, grayscales, pastel pink, blue, 

yellow)
- New Effects browser v1.5:

      -    Total new look for easier use
      -    Several bugs concerning closing the application after an effect: fixed
      -    Render gave wrong displacement : fixed
      -    Zoom gave wrong displacement: fixed
      -    Color picker enhanced with RGB color pallet picker
      -    New: Spot light aperture size
      -    Default effect settings improved
      -    New: mirror image horizontal
      -    New: mirror image vertical
      -    Color selector always on top
      -    User selected color (in Avancepaint) now default in color-selector



      -    New Pro Edition effect: Anti Aliasing!
      -    transparency color for zoom, rotate and rendering
      -    Render picture displacement
      -    Bug fix: zoom, render and rotate centering image not always correct: fixed
      -    general debugging
      -    Spot light now updates automatically after moving image
            - New Text functions (Pro Edition)
            - font, bold, italic, underline
            - 3D shadow text 
            - all fonts added 
            - text entry now logically placed
            - Text updates automatically after moving (Tip: After apply use it to create 3D)

- AvancePaint Brightness/Contrast:
    -    preview enlarged
    -    centre image
    -    flickering when moving image: fixed
    -    more speed
    -    Reset back to original image

- Pencil -> acts as an Eraser when right mouse-button is pressed 
- Right click when using Color Picker Tool sets now the background color
- double click html color code -> clipboard
- Right-click Circle icon -> allows drawing Bezier curves

- 3D borders (Pro Edition) enhanced:
    -    thickness between 1 and 20 points
    -    New: extra 3D border “etched”

- Borders improved with:
    -    now a pallet of 50 colors (instead of 18)
    -    size adjusted according to selected border
    -    resize border allowing background color change in solid colors (dual color 
borders)
    -    general debugging

- New effect: Interlacing, Crease and Moody (replacing blur, brighten, darken, emboss as
it is already available in AvancePaint itself)
- All effects debugged and enhanced
- Effects enabled in Free Edition: Crease, Diffuse, Interlacing!
- Major effect updates of: Sharpen (5 styles: Pro), Psychedelic (now 5 extra effects: Pro),
Emboss, Black & white, Jagged (Pro), Striped (user color, step size: Pro), Moody (Pro)
- Free Edition effects available for download: Emboss, Blur, Grayscale, Brighten, Darken 
- New Statue effect!
- Pro effects available for download: Lighting Blur (and many more will follow)!
- Add Free Edition effects up to 4 extra free downloadable effects
- Speedup some effects: grayscales, color scales, bright/contrast

- Convert single Color Scale New -> black & white, yellow, purple, cyan
- New: Cyan color pallet added to the main color pallet
- New in Draw Text : Center text , left justify,    Font



- Copy/Paste bug fixed - After paste user needed to click the selection to allow moving 
the pasted image, now automatic
- Bug: Blend and transparency during Selection did not work: fixed!
- 8 new textures!
- 4 user selected Textures stored for next use
- Bug fix: Transparency fixed with Paste and with inserting Symbols
- New: ESC during effect stops the current running effect (to stop effect press ESC-key)
- 28 new symbols!

- Associate JPG, BMP or GIF with AvancePaint to open these files from within the Explorer

- and much more!

Version 2.1
- Main screen toolbar-icons updated
- Erase (white, black, background color) image did not work when using an opened 
picture
- Sharpen effect view enlarged
- Jagged effect did only a part of the screen, fixed
- Soften-, Smooth, Crease and Decolorize effects had a cyan line at the right edge, fixed
- UNDO when applying an effect inside a selection and pressing the X (undo effect) did 
not always undo the last applied effect, fixed
- with some external effects a line(s) at the edges of the image was shown: fixed
- Borders: selecting user border is now done with one click (no double click anymore)
- Effects browser update (v1.6)
    - Autozoom when larger pictures was to small format: fixed
    - Centre smaller images in the viewport
    - Emboss, Engrave, Relief gave sometimes a line on the side: fixed
    - Colorpicker position better placed
- Right-click Fill tool opened Texture fill -> removed in v2.1 but now placed in the Fill 
toolbar
- Freehand dots/donuts as new pencil
- Some general debugging

Legal Stuff
1. LICENSE GRANT.    Subject to the provisions contained herein, the Author grants you a 
license to use the version of this SOFTWARE for private non-commercial use free of charge. 
"Use" means storing, loading, installing, executing or displaying the SOFTWARE. Commercial 
user will require a separate license from the author. Contact the author for details on obtaining a
license for commercial use.

2. OWNERSHIP.    The SOFTWARE is owned and copyrighted by the Author. Your license 
confers no title or ownership in the SOFTWARE and should not be construed as a sale of any 
right in the SOFTWARE .    

3. COPYRIGHT.    The SOFTWARE is protected by the Copyright law and international treaty 
provisions. You acknowledge that no title to the intellectual property in the SOFTWARE is 
transferred to you.    You further acknowledge that title and full ownership rights to the 
SOFTWARE will remain the exclusive property of the Author and you will not acquire any rights 



to the SOFTWARE except as expressly set forth in this license. You agree that any copies of the
SOFTWARE will contain the same proprietary notices which appear on and in the SOFTWARE.

4. REVERSE ENGINEERING. You agree that you will not attempt to reverse compile, modify, 
translate, or disassemble the SOFTWARE in whole or in part.

5. NO OTHER WARRANTIES.    THE AUTHOR DOES NOT WARRANT THAT THE 
SOFTWARE IS ERROR FREE. THE AUTHOR DISCLAIMS ALL OTHER WARRANTIES WITH 
RESPECT TO THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS.    SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW 
LONG AN IMPLIED WARRANTY MAY LAST, OR THE EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR 
EXCLUSIONS MAY NOT APPLY TO YOU.    THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION 
TO JURISDICTION. 

6. SEVERABILITY.    In the event of invalidity of any provision of this license, the parties agree 
that such invalidity shall not affect the validity of the remaining portions of this license.    

7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES.    IN NO EVENT SHALL THE AUTHOR 
OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, 
INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, 
PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF THE AUTHOR HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT WILL THE AUTHOR 
LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR ANY OTHER THEORY OF 
LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

8. LIMITED DISTRIBUTION LICENSE. Permission is granted to individuals charging no fees, 
and to BBSes User Groups, Mail-Order Disk Vendors, CD-ROM publishers, and BBS File-
Distribution Networks, Networks regardless of fees, to distribute the SOFTWARE, provided they 
convey a complete and unaltered copy of this product, and provided they claim no ownership of 
these products.

9. ENTIRE AGREEMENT.    This is the entire agreement between you and the Author which 
supersedes any prior agreement or understanding, whether written or oral, relating to the 
subject matter of this license.

You may distribute this evaluation copy to friends and colleagues but 
you must include all files in the original distribution.    

Please encourage them to register their copy if they find that they make use of it.



Request the Pro-Edition

Request the Pro-Edition

AvancePaint and Free Edition
AvancePaint is NOT public domain! The author keeps the copyright and all other rights. 
The program can be used without registering or payment for unlimited time.
To enjoy extra features, support and options you can register AvancePaint and so receiving the 
Pro Edition key. To register AvancePaint please send 10 Euro (13 US$).
You can donate via PayPal, by post or our bank account.
Registered users will also enjoy free support, free updates! And…the key remains valid in every 
future version or update!!!

This version is not crippled in anyway and fully functional in all respects!
Nevertheless, you can upgrade this copy to the Professional Edition which gives 

you extra functionality options and support. 
Registering the Pro Edition can be done by donating to the RGS-Avancepaint project 

(via our PayPal account or bank account)

Please read further to discover the advantages of registering this free product.

When registering this free software product you’ll get extra benefits to show you my appreciation. 
Registering this product can be done with a donation as little as 10 euro/dollars to this project.
Your donation will support and ensure this product for future updates! 

AvancePaint DONATIONS to register and request the Pro-Edition
There are 3 ways to donate to the AvancePaint project and receive the Pro-Edition 
registration key:
· Via our PayPal account at our website http://users.belgacom.net/rgs/avancepaint.htm

where you can find our PayPal account  
This is a fastest, easiest and most secure way!

· or donate 10 Euro or 13 US$ at our financial account

· beta-testers or people who made a special effect that has been approved by our team 
and which may be distributed get a free registration key!

Donations can be paid at financial account (without any additional costs):
For inside Belgium:
 Guy Roels
 833-5030059-91 (in Euro).

Donators from outside Belgium will not have to pay any additional 
banking costs if they use the following international banking number (IBAN)
and mention the international identification code (BIC): 



 Guy Roels
 IBAN: BE23 8335 0300 5991    
 BIC: GKCCBEBB      

Without any additional cost for international money transfer, even the smallest donation is useful
and will be most appreciated. 

Please don't forget to reference the transfer as “ Donation AvancePaint ”. 

Remember: beta-testers or people who made a special effect that has been approved by our 
team and which may be distributed get a free registration key!
Advantages of the Pro-Edition

AvancePaint SUPPORT
If you have questions, want to stay in touch on the latest developments and updates or if you 
want more info about anything related to AvancePaint please visit our website: 
 http://users.belgacom.net/rgs 



Make your own effects

You can program your own effects in almost any available language which you can compile 
to an exe!

It's quite simple...

1. Create your effect application and make it load the given filename on load 
(in VB: use command$, this will have the path of the active image in AvancePaint with 
name ‘effect.bmp’)

2. Then modify the image as you want to

3. And save the file to the original file name and path 
(in VB: the one you got from command$)

4. Then compile and place the .exe in the AvancePaint\Effects folder

5. Important for Free Edition users: name your effect starting with a number between 0-9
Example: 1MyEffect.exe
Maximum 6 effects can be made in the Free Edition

6. Pro Edition users can use any name and unlimited number of effects! 

Visual-Basic Example
This example shows you how to invert an image.

· Open a new project
· Put an image object on the form and resize it to fit your Form and name it ’ImgPreview’.
· Set the properties of the Image-object to: Stretch=True
· Place a picturebox on your screen (size does not matter) and name it ‘Source’
· Set the properties of picturebox (Source) to: AutoRedraw=True, AutoSize=True and 

Visible=False
· Put a Command-object on your form and name it CmdPreview
· Put a Command-object on your form and name it CmdWhatToDo, copy it and past it on 

your form
· Now copy the source code below and paste it into your project

'
'RGS-AvancePaint effect example
'Guy Roels (c)2006 RGS-AvanceSoft
'http://users.belgacom.net/rgs
'
Dim Parameter As String

Private Sub CmdPreview_Click()

'In this example RasterOp Constants are used

'restore before applying the effect
Me.ImgPreview = Me.Source
'Invert
Me.Source.PaintPicture Me.Source, 0, 0, Source.Width, Source.Height, 0, 0, , , 
vbDstInvert
'Give the inverted image to the preview image



Me.ImgPreview = Me.Source.Image

End Sub

Private Sub CmdWhatTodo_Click(Index As Integer)

    Select Case Index
    
        Case 0
        'save it
        SavePicture Me.Source.Image, Parameter '"test2.bmp"
        
        Case 1
        'exit without save
                    
    End Select
    
    End
    
End Sub

Private Sub Form_Load()
    
    'get the path, filename and possible parameters from your GFX program
    Parameter = Command$
    
    'to test your effect, enter the name of your picture below and unremark it
    'Parameter = "test.bmp"
    
    'close Effect if nothing as parsed
    If Parameter = "" Then End
    
    'load the picture
    Me.Source.Picture = LoadPicture(Parameter)
    'Give the image to the preview
    Me.ImgPreview = Me.Source

End Sub

· Now you just need to compile it and place it into the Effects folder. Next time you start 
Avancepaint your effect will be in the Effects-menu!

You can always remove (or rename the filename of the effect(s) to .bak) one or more effects 
which you do not use if you want. Just go to the Effects folder where you installed AvancePaint 
and delete the effect(s) you do not need (or rename them to .BAK).

Please don’t hesitate to mail me your effects if you want them to be put on our website (if found 
good enough by our team). Feel free to place your own created effects on your own website too,
but please send me a little mail. This way we can link to your website which can only profit the 
users. You can even get your registration key for free that way!

Note: The Pro-Edition has no limit of effects, nor has it a limit in user programmed effects! No 
need to rename or whatever to enable your effects inside AvancePaint. All available effects will 
always accessible in the Pro-Edition.



Features

Features
· Compatible with ALL Windows versions (including Windows Vista)
· Intuitive user interface
· Open and edit unlimited (as memory allows) number of photo’s or pictures
· Open and edit JPG, JPEG, BMP, GIF, WMF, ICO, DIB formats
· Draw advanced Bezier curves and Polygons
· Import images directly from your scanner, webcam etc.!
· Save JPG’s with user selectable compression quality
· Save GIF’s with user selectable transparent color
· Draw rectangles, circles, elliptical filled or not, borders, rounded rectangles, 

arrows, 3D-borders…
· Freehand drawing with selectable brushes
· Masks
· Brighten, darken, contrast
· Sharpen, soften, blur
· Blend, paste transparent, blend reverse…
· Size and crop any image or parts of an image
· 30 photographical effects (expandable)
· Create your own effects using VB or any other language!
· Fill solid, Fill with gradients, Fill with several patterns, with textures etc…
· User selectable textures (tiles)
· Flip horizontal, vertical, rotate…
· Color replace
· Print preview
· Real style and visible font selections
· A full set of easy to select colors. Easy to use fixed colors, user defined colors, 

true-color pallets and more
· Zoom
· More then 40 textures and tiles which can be extended
· Effects Browser (24 photographical effects):

Ambient light, Emboss, Blur, Sharpen, Brightness, Gamma, Grayscale, Gridlines,
Hue, Inversion, Engrave, Mosaic, Tone, Render, Replace color, Light, Zoom, 
Text, Relief, Anti Aliasing…

· And much more…

Pro-Edition Overview



Total External Extra Effects Summary:

Free Edition
                  “
                  “
                  “
                  “
                  “
Pro Edition (and all of the above)
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “

The Effects Browser Summary:

Ambient light
Emboss
Blur
Sharpen
Brightness
Gamma
Grayscale
Gridlines
Hue
Inversion
Engrave
Mosaic
Tone
Render
Replace colors
Light
Text
Relief
Spotlight
Zoom
Special Text effects
Anti Aliasing

Free Edition
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
                  “
Pro Edition (and all of the above)
                  “
                  “
                  “

You can always remove (or rename the filename of the effect(s) to .bak) one or more effects 
which you do not use if you want. Just go to the Effects folder where you installed AvancePaint 
and delete the effect(s) you do not need (or rename them to .BAK).

Please don’t hesitate to mail me your effects if you want them to be put on our website (if found 
good enough by our team). Feel free to place your own created effects on your own website too,



but please send me a little mail. This way we can link to your website which can only profit the 
users. You can even get your registration key for free that way!

Note: The Pro-Edition has no limit of effects, nor has it a limit in user programmed effects! No 
need to rename or whatever to enable your effects inside AvancePaint. All available effects will 
always accessible in the Pro-Edition.



Tips and tricks

You can let an effect loose on a part of an image too.
Click on the Area Selector tool and mask a part of the image you want to change
Now choose your desired effect or whatever option you want (like, flip, rotate, grayscale 
and any other effect)

 The Area selection tool is a very powerful tool which you can use to change parts of the 
image and not the entire image

You can paste an image from any location: open Edit menu: use “Paste From…”: select the 
image you want

You can copy a part of the image and save it: open Edit menu: use “Copy To…”: save the image
to the directory you want

Right-click on the image or selection will show you a bunch of options.

Eraser: just by clicking the right mouse-button inside your image uses the background color 
instead of the foreground color to paint/draw (Eraser)

Background color can always be selected using the right mouse button

Replacing colors can be very useful. The color to replace is selected with the left mouse button, 
the color you want to change is selected with the right mouse button.

AvancePaint has several Undo’s. Keep on clicking the Undo icon (or choose Undo from the 
menu) till you get where you want.

You can copy and paste from one opened image to another, or make a copy of an existing 
image.
To make a duplicate of your image: Edit menu: Select All: Copy: Paste as New

When you copy an image from another application you can paste it into your image OR you can 
paste it as a new image. Edit menu: Paste      OR Edit menu: Paste as New

Fill a selection with a texture: Select an area with the selection tool: open Tools menu: click on 
Textures: select the desired texture

Fill options: You can have two major ways to Fill: 
the standard way which is multicolored boundaries. This means that the fill will stop until it reach
a different color then the selected one
the second way is to Fill the area bounded by the selected color (when you check 

). This will fill your image till it finds the selected color. Experiment with both and you’ll soon 
know how it works
Remember that the fill option can be used to fill patterns and with the foreground- and 
background color you selected too (ex. 

….)



Revert to saved image is ideal to quickly go back to the last saved copy of your image!

You can choose from 28 fixed Textures and tiles or from 20 textures which can be found in the 
Texture folder. You can browse your HD for other textures (unlimited in the registered version) or
you can copy your favorite textures with your Explorer and put them in the \Texture folder.

You can always remove (or rename the filename of the effect(s) to .bak) one or more effects 
which you do not use if you want. Just go to the Effects folder where you installed AvancePaint 
and delete the effect(s) you do not need (or rename them to .BAK).
Pro Edition users can have unlimited effects and all accessible! 

In the Effects Browser (Pro Edition) or even in the standard text option in AvancePaint you can 
create extra special shadow or 3D effects bij applying your text to the image in a certain color 
and then ‘overlaying’ the same text slightly offset from the first and in another color. Could look 
like this: 

Area Selection and Selection tool

The Area selection tool is a very powerful tool which you can use to change parts of the image
and not the entire image

- You can let an effect loose on a part of an image too.
Click on the Area Selector tool and mask a part of the image you want to change
Now choose your desired effect, use the Effects Browser or whatever option you 
want (like, flip, rotate, grayscale and any other effect) 

- Fill a selection with a texture: Select an area with the selection tool: open Tools 
menu: click on Textures: select the desired texture 

- Copy a the selected part to the Clipboard or to another section of your image



Selection tool explained

After a selection has been made (Area Selection) or when you pasted an image, you’ll get the 
above options (click on the Selection tool – gold arrow - if you do not see these options after a 
selection or paste):

Use a transparent color (default your current background color), or you can select a color by 
double clicking the transparency color square (example: white color - see above)
Then click on Action v to apply your transparency! This is important!
Same goes for blending an image.
To blend an image (blending is making an image seem like partial transparent) tick the blend 

square (0 %) and type or use the horizontal slider to change the blend (transparency) 
power.    

Then click on Action v to apply your transparency! This is important!
Same can be done when inserting Symbols



Associate pictures

You can associate BMP, JPG or GIF files with AvancePaint during installation. Associating the 
file extensions allows you to automatically open AvancePaint with the picture you double-click 
from within the Explorer.

If you did not tick the associate options in the install program, then just install AvancePaint again
and tick the desired picture types (.BMP, .JPG or .GIF) you want to be opened by AvancePaint 
in your Explorer.

Note:
Some programs (like Irfanview) associate these file type extensions also and can override 
AvancePaint associations. This could resolve into not being able to associate these files with 
AvancePaint.
You can solve this by un-associating the extensions you want for AvancePaint (bmp, jpg, gif) in 
the program (ex. Irfanview and others).



Closing words

And a special thanks to those who mailed me their AvancePaint comments, support and 
suggestions. 

Special thanks to the AvancePaint beta-testers!!!
And to all who are using AvancePaint!

AvancePaint SUPPORT

If you have questions, want to stay in touch on the latest developments and updates or if you 
want more info about anything related to AvancePaint please visit our website: 
http://users.belgacom.net/rgs 

Thank you in advance and thank you for choosing AvancePaint,
RGS

Twain: import images from scanner

You can import images from your scanner/copier bij using the new Twain feature (v2.0 and up) 
in AvancePaint!

Run AvancePaint…

If you have more then one twain device then please select the desired device before using 
“Acquire Image”. Go to File -> “Select Twain Source”

and go to File -> Acquire Image… and follow the instructions. 
After the scan the image will appear in AvancePaint

Important: some scanners take a lot of time to initiate, so please be patient as it may seem the 
program ‘hangs’.

Note:
If the Twain options in the File-menu are grayed out (disabled) then this means that your 
system has no Twain compatible devices installed.

About TWAIN: TWAIN as an API for High Throughput Image Capture

TWAIN is well suited as an API for image capture systems that produce large images,
large numbers of images or both.
History
TWAIN has been the API of choice for low volume image capture on Microsoft
Windows and Apple Macintosh platforms since the early 90’s; Yet people wanted to scan and 
work with images like this, as well as grayscale and color, and TWAIN was designed to help by 



providing efficient mechanisms for transferring images between the Source and the Application. 

Today, personal computers have sufficient performance to meet high volume capture needs 
and so does TWAIN. Since 1997 the TWAIN Working Group has expanded the TWAIN 
Specification to provide better programmatic control of high volume capture devices and digital 
cameras. This work has progressed because of the recognition that TWAIN performs well with 
these classes of devices.




